Please read this guide, including all Precautions, before using this label printer. After reading this guide, keep it in a safe place.

For FAQs, Troubleshooting, and to download the label printer’s software and manuals, visit support.brother.com.

### Supplies

<table>
<thead>
<tr>
<th>Supplies</th>
<th>Widths</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brother TZe Tape Cassette</td>
<td>0.13, 0.23, 0.35, 0.47, 0.70, 0.94 in.</td>
</tr>
<tr>
<td></td>
<td>3.5, 6, 9, 12, 18, 24 mm</td>
</tr>
<tr>
<td>Head Cleaning Tape Cassette</td>
<td>TZeCL4</td>
</tr>
<tr>
<td>Rechargeable Li-ion Battery</td>
<td>PA-BT-005</td>
</tr>
</tbody>
</table>

• Brother reserves the right to make changes without notice in the specifications and materials contained herein and shall not be responsible for any damages (including consequential) caused by reliance on the materials presented, including but not limited to typographical and other errors relating to the publications.

• Unauthorized duplication or reproduction of any or all content of this document is prohibited.

• Please note that we cannot assume any responsibility for any damage or lost profit arising from the use of the label created with this label printer or the disappearance or change of data due to failure, repair or consumables using battery, or any claim from a third party.
# Table of Contents

1 **Precautions**  
   Safety Precautions .......................................................................................................................... 1  
   General Precautions ....................................................................................................................... 2  

2 **Set Up Your Label Printer**  
   Parts Description .............................................................................................................................. 3  
   Insert the Tape Cassette .................................................................................................................. 4  
   Charge the Battery .......................................................................................................................... 5  
   Remove Battery for Replacement or Disposal ............................................................................. 6  
   Turn Power On or Off ...................................................................................................................... 7  

3 **Print from Your Mobile Device**  
   Pair the Label Printer with Your Mobile Device ........................................................................... 9  

4 **Print from Your Computer**  
   Windows .......................................................................................................................................... 11  
   Create Labels with P-touch Editor ............................................................................................ 11  
   Configure Settings Using the Printer Setting Tool .................................................................... 12  
   Apply Settings Changes to Multiple Label Printers .............................................................. 13  
   Update Software ......................................................................................................................... 13  
   Update Firmware ....................................................................................................................... 13  
   Mac ............................................................................................................................................... 14  
   Create Labels with P-touch Editor .......................................................................................... 14  
   Configure Settings Using the Printer Setting Tool .................................................................. 14  
   Apply Settings Changes to Multiple Label Printers .............................................................. 15  
   Update Firmware ....................................................................................................................... 15  

5 **Appendix**  
   Maintenance ................................................................................................................................. 16  
   Clean the Label Printer Exterior ............................................................................................. 16  
   Clean the Print Head ............................................................................................................... 16  
   Clean the Tape Cutter .............................................................................................................. 17  
   Troubleshooting ......................................................................................................................... 18  
   LED Indications ........................................................................................................................ 18  
   LED Troubleshooting ............................................................................................................... 19  
   Product Specifications .............................................................................................................. 22  
   Trademarks ............................................................................................................................... 23
Precautions

Safety Precautions

Follow these guidelines to avoid the risk of heat generation, smoking, explosion, fire, or injury.

**DANGER**  Failure to observe instructions and warnings will result in death or serious injuries.

Rechargeable Li-ion Battery
- Do not allow the battery to come into contact with liquids.
- Do not charge, use, or leave the battery in high temperature (above 140°F / 60°C) locations.
- Use the included USB cable to charge.
- Use the battery only for its intended purpose.
- Keep the battery away from heat and fire.
- Do not connect the + and - terminals with metal objects such as wire. Do not carry or store the battery with metal objects.
- Do not throw, hit or damage the battery in any way.
- Do not solder any connections to the battery.
- Do not disassemble or modify the battery.
- Do not dispose of the battery with household waste.

**WARNING**  Failure to observe instructions and warnings could result in death or serious injuries.

Rechargeable Li-ion Battery
- Keep the battery away from infants. If the battery is ingested, seek immediate medical advice.
- Stop using the battery if there are noticeable abnormalities such as smell, heat, deformities, or discoloration.
- If liquid from the battery gets into your eyes, wash them with clean water and see a doctor immediately.

Label Printer and USB Cable
- Use the included USB cable to prevent any damage.
- Do not use during a thunderstorm.
- Do not damage.
- Do not place heavy objects on.
- Do not forcibly bend or pull.
- Do not disassemble or modify.
- Do not drop or hit.
- Do not allow to come into contact with liquids.
- If you notice abnormalities such as smell, heat generation, discoloration, or deformation while in use or storage, stop using the label printer, disconnect the USB cable, and remove the battery.
- When the label printer is not being used, store it out of the reach of children. In addition, do not allow children to put any label printer parts or labels in their mouths. If ingested, seek immediate medical advice.
Precautions

⚠️ CAUTION ⚠️ Failure to observe instructions and warnings could result in minor or moderate injuries.

Rechargeable Li-ion Battery
If liquid from the battery gets onto skin or clothes, immediately rinse them with water.

Label Printer and USB Cable
- Use the dedicated battery (PA-BT-005).
- When opening and closing the Cassette Cover, use caution to prevent your fingers from being trapped.
- Do not touch the Print Head.
- Do not touch the cutter blade or insert your fingers inside the Tape Exit Slot.

General Precautions

Label Printer, Tape Cassette, or USB Cable
- Do not use in any way or for any purpose not described in this guide. Doing so may result in accidents or damage.
- Use Brother Tape Cassettes.
- Do not put any foreign objects into the Tape Exit Slot, the USB Port, battery compartment, etc.
- Do not place in any location exposed to extremely high or low temperatures, high humidity, or dust, such as direct sunlight, rain, near heaters, other hot appliances, on the dashboard, or in the back of your car.
- Do not try to print if the cassette is empty; it will damage the Print Head.
- Do not pull the tape while printing or feeding; it will damage the tape and the label printer.
- The length of a printed label may differ from the displayed label length.
- Depending on the location, material, and environmental conditions, labels may unpeel or become irremovable, or the color may change or be transferred to other objects. Before applying labels, check the environmental conditions and the material.
- When printing multiple copies of a label, the label printer will not detect the end of the tape cassette and will continue printing.
- Printed characters may look different than previewed, as your device’s or computer’s screen may have a higher resolution than the label printer.
- Printed small text may not be as clear as it is displayed.
- White and Gold printed objects may not always print clearly.
- The backing of some types of tapes may be pre-cut to make it easier to peel the backing. To remove the backing, simply fold the label lengthwise with the text facing inwards to expose the inside edges of the backing. Next, peel off the backing one piece at a time.
- Labels may be difficult to attach to surfaces that are wet, dirty, or uneven. The labels may peel off easily from these surfaces.
- For rough and textured surfaces, we recommend using Extra Strength Adhesive Tape.
- Be sure to read the instructions provided with Fabric Tapes, Extra Strength Adhesive Tapes, or other special tapes and observe all precautions noted in the instructions.
Set Up Your Label Printer

Parts Description

- Power LED
- Tape Exit Slot
- Power Button
- Battery LED
- USB Port
- Cassette Cover
- Tape Guide
- End of Tape
Insert the Tape Cassette

1. Place your fingers on the Tape Exit Slot.

2. Open the Cassette Cover by pulling the Tape Exit Slot to the left.

   Pull out the protective sheet (first time only).

3. Confirm that the tape is pointed at the Tape Exit Slot and gently press the Tape Cassette into the label printer until it locks into place.

   • Make sure that there is no slack in the tape. To fix any slack, pull the end of the tape out of the Tape Guide.

   • When inserting or removing the Tape Cassette, make sure that the tape does not catch on the label printer.

4. Close the Cassette Cover.
Charge the Battery

Connect the label printer to the computer using the included USB cable, or connect the USB cable to a USB AC Adapter suitable for charging mobile devices, and plug the adapter into a power source. Charge until the Battery LED turns off.

- Use the included USB cable.
- If charging the battery using a computer, make sure the computer is on.

Notes on Using the Rechargeable Li-ion Battery
- Charge the battery in environments between 50°F and 95°F / 10°C and 35°C, otherwise the battery will not charge, and the Battery LED will remain lit.
- If the label printer is used to print, feed, or perform another operation while charging, charging may stop even though the battery is not fully charged. Charging resumes when the operation is completed.

Rechargeable Li-ion Battery Characteristics
To ensure the highest performance and longest life from the rechargeable Li-ion Battery, when storing the label printer for a long period of time:
- Charge once every six months.
- Store in a cool dry place out of direct sunlight, between 50°F and 95°F / 10°C and 35°C.
Remove Battery for Replacement or Disposal

1. Turn the label printer off.
2. Open the Cassette Cover.
3. Remove the two screws from the Battery Cover using a flat-bladed screwdriver.
4. Remove the battery.

- Dispose of batteries at an appropriate collection point. Be sure to observe all applicable local regulations.
- When storing or discarding a battery, cover the contacts with cellophane tape to prevent it from short-circuiting.

5. When reinserting the battery, make sure the battery’s contacts are touching the contacts inside the battery compartment.
6. Replace the Battery Cover, reinsert the screws, and tighten them with a flat-bladed screwdriver.
7. Close the Cassette Cover.

DANGER
Do not dispose of the battery with household waste. There is a risk of environmental damage, explosion, or fire.
# Turn Power On or Off

<table>
<thead>
<tr>
<th>Status</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power On</td>
<td>Press the Power Button.</td>
</tr>
<tr>
<td>Power Off</td>
<td>Press and hold the Power Button until the Power LED turns off.</td>
</tr>
</tbody>
</table>
• Press the Power Button twice quickly to feed and cut the tape.
• When the Auto Cut option is selected, the minimum print length is 0.98 in. / 25 mm.
• Before each initial print, the label printer feeds an approximately 1 in. / 25 mm of blank tape.
• We recommend not selecting the Auto Cut option when printing multiple labels less than 0.98 in. / 25 mm. This will save tape.

---

Download the P-touch apps from the App Store or Google Play™.

<table>
<thead>
<tr>
<th>iPrint&amp;Label</th>
<th>Create labels for business use, including barcodes, office equipment labels, and labels for folder tabs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-touch Design&amp;Print</td>
<td>Design and create stylish labels for work or home.</td>
</tr>
</tbody>
</table>

---

- Download the P-touch apps from the App Store or Google Play™.
Print from Your Mobile Device

Pair the Label Printer with Your Mobile Device

**On your mobile device:**
1. Go to the settings menu and make sure the Bluetooth® option is on.
2. Select **PT-P710BT****** (where **** is the last four digits of your label printer’s serial number. The unit's serial number is located inside the Cassette Cover, underneath the TZe Tape Cassette.).

- If asked to enter a PIN Code, enter "0000".
- Pairing instructions may differ slightly, depending on your mobile device.
- If your label printer is not found by your mobile device, your label printer may already be connected to another device. If so, turn off Bluetooth on that device, or turn your label printer off and then on again.
- This label printer does not support Wi-Fi connections.
- If your label printer is not found by your mobile device, make sure the label printer is not in sleep mode.
Visit **install.brother** and install the printer driver and P-touch Editor by following the on-screen instructions.

<table>
<thead>
<tr>
<th>The following software can be selected for installation:</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Driver</td>
<td>Software required to print from a label printer.</td>
</tr>
<tr>
<td>P-touch Editor</td>
<td>Label creation software for computers. This application comes with built-in drawing tools that allow you to print a wide variety of custom labels in complex layouts with text of different fonts and styles, frames, imported images, barcodes, etc.</td>
</tr>
<tr>
<td>P-touch Update Software</td>
<td>Update applications to the latest version. Visit <a href="http://support.brother.com">support.brother.com</a> to update P-touch Editor for Mac.</td>
</tr>
<tr>
<td>Printer Setting Tool</td>
<td>Configure settings for the label printer.</td>
</tr>
</tbody>
</table>
Print from Your Computer

Windows

Create Labels with P-touch Editor

1. Connect the label printer and your computer with the included USB cable.
2. Double-click the P-touch Editor icon on the desktop.
3. Create a new layout or open an existing layout.
4. Select the mode as necessary:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Features</th>
<th>Print Settings Change</th>
<th>How to Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Express</td>
<td>This mode allows you to quickly create layouts that include text and images.</td>
<td>Yes</td>
<td>Click the print icon &gt; Print</td>
</tr>
<tr>
<td>Professional</td>
<td>This mode allows you to create layouts using a wide-range of advanced tools and options.</td>
<td>Yes</td>
<td>File menu &gt; Print &gt; Print</td>
</tr>
<tr>
<td>Snap</td>
<td>This mode allows you to create custom layouts at any time by keeping the P-touch Snap palette displayed on your monitor. • Screen Capture function • Drag-and-Drop function • Print Text function</td>
<td>No</td>
<td>Click the print icon &gt; Print</td>
</tr>
</tbody>
</table>

Options

<table>
<thead>
<tr>
<th>Functions (Multiple selection is possible for some options)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Cut</td>
</tr>
<tr>
<td>Chain Printing</td>
</tr>
<tr>
<td>Special tape</td>
</tr>
<tr>
<td>Mirror Printing</td>
</tr>
</tbody>
</table>

- Press the Power Button twice quickly to feed and cut the tape.
- When the Auto Cut option is selected, the minimum print length is 0.98 in. / 25 mm.
- Before each initial print, the label printer feeds an approximately 1 in. / 25 mm of blank tape.
- We recommend not selecting the Auto Cut option when printing multiple labels less than 0.98 in. / 25 mm. This will save tape.
- The Cable Labeling Wizard allows you to create layouts for electrical equipment management.
- This label printer does not support Bluetooth connections for computers.

To select the layout
- Double-click the layout icon.
- Select the layout icon, then click the arrow mark.

To change the P-touch Editor startup settings
1. Click the Tools menu, and select > Options.
2. In the Options window, select General and select the startup setting you want from Operations.
Configure Settings Using the Printer Setting Tool

1. Connect the label printer and your computer with the included USB cable.
2. Start the Printer Setting Tool.

<table>
<thead>
<tr>
<th>Operating System Version</th>
<th>How to Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7</td>
<td>Start &gt; All Programs &gt; Brother &gt; Label &amp; Mobile Printer &gt; Printer Setting Tool</td>
</tr>
<tr>
<td>Windows 8/Windows 8.1</td>
<td>Apps &gt; Printer Setting Tool</td>
</tr>
<tr>
<td>Windows 10</td>
<td>Start &gt; Brother &gt; Printer Setting Tool</td>
</tr>
</tbody>
</table>

3. Click **Device Settings**.

The following settings can be changed:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Power On</td>
<td>Configure whether the label printer turns on automatically when it is connected to a USB AC adapter or a computer.</td>
</tr>
<tr>
<td>Auto Power Off</td>
<td>Set the period of time before the label printer turns off automatically when it is connected to a USB AC adapter or a computer.</td>
</tr>
<tr>
<td>Auto Power Off (Li-ion)</td>
<td>Set the period of time before the label printer turns off automatically.</td>
</tr>
<tr>
<td>Contents</td>
<td>Configure the label printer information that will be printed.</td>
</tr>
<tr>
<td>Length Adjustment</td>
<td>Adjust the length of the printed label to match the length of the label displayed on the computer.</td>
</tr>
</tbody>
</table>

4. Click **Apply > Exit**.
5. Click **Exit** in the main window.

- Check that the label printer you want to configure appears next to **Printer**. If a different label printer appears, select your label printer from the drop-down list.
- Do not perform another job while changing the settings.
Apply Settings Changes to Multiple Label Printers

1. After applying settings to the first label printer, disconnect the label printer from the computer.
2. Connect the second label printer to the computer.
3. Select the newly connected label printer from the Printer drop-down list.
4. Click Apply.

Repeat steps 1 to 4 for all label printers whose settings you want to change.

- To save the current settings in a file, click File > Export.
- The same settings can be applied to other label printers. Click File > Import, then select the exported file.

Update Software

1. Double-click the P-touch Update Software icon on the desktop.
2. Click the Computer software update icon.
3. Select the Printer and Language, select the check boxes next to the software you want to update, and then click Install.

Close all other Brother applications.

Update Firmware

1. Turn on the label printer, and connect it to your computer with the included USB cable.
2. Double-click the P-touch Update Software icon on the desktop.
3. Click the Machine update icon.
4. Select the Printer, ensure that The machine is connected correctly. appears, and then click OK.
5. Select the Language, select the check boxes next to the firmware you want to update to, and then click Transfer.
6. Click Start.

- Do not power off or disconnect the USB cable while updating.
- Close all other Brother applications.
Print from Your Computer

Mac

Create Labels with P-touch Editor

1. Connect the label printer and your computer with the included USB cable.
2. Click **Macintosh HD > Applications > P-touch Editor**.
3. Select a new template or a template category.

- Press the Power Button twice quickly to feed and cut the tape.
- When the Auto Cut option is selected, the minimum print length is 0.98 in. / 25 mm.
- Before each initial print, the label printer feeds an approximately 1 in. / 25 mm of blank tape.
- We recommend not selecting the Auto Cut option when printing multiple labels less than 0.98 in. / 25 mm. This will save tape.
- This label printer does not support Bluetooth connections for computers.

Configure Settings Using the Printer Setting Tool

1. Connect the label printer and your computer with the included USB cable.
2. Click **Macintosh HD > Applications > Brother > Printer Setting Tool > Printer Setting Tool**.
3. Select any of the Settings tabs, and then configure the settings.
4. Click **Apply Settings to the Printer**.
5. Click **Exit**.

- Check that the label printer you want to configure appears next to **Printer**. If a different label printer appears, select the label printer from the drop-down list.
- Do not perform another job while changing the settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Power On</td>
<td>Configure whether the label printer turns on automatically when it is connected to a USB AC adapter or a computer.</td>
</tr>
<tr>
<td>Auto Power Off</td>
<td>Set the period of time before the label printer turns off automatically when it is connected to a USB AC adapter or a computer.</td>
</tr>
<tr>
<td>Auto Power Off (Li-ion)</td>
<td>Set the period of time before the label printer turns off automatically.</td>
</tr>
<tr>
<td>Length Adjustment</td>
<td>Adjust the length of the printed label to match the length of the label displayed on the computer.</td>
</tr>
</tbody>
</table>
Print from Your Computer

Apply Settings Changes to Multiple Label Printers

1. After applying settings to the first label printer, disconnect the label printer from the computer.
2. Connect the second label printer to the computer.
3. Select the newly connected label printer from the Printer drop-down list.
4. Click Apply Settings to the Printer.

Repeat steps 1 to 4 for all label printers whose settings you want to change.

- To save the current settings in a file, click Export.
- The same settings can be applied to other label printers. Click Import, then select the exported file.

Update Firmware

1. Turn on the label printer, and connect it to your computer with the included USB cable.
2. Click Macintosh HD > Applications > P-touch Update Software.
3. Click Machine update.
4. Select the Printer, ensure that The machine is connected correctly. appears, and then click OK.
5. Select the Language, select the check boxes next to the firmware you want to update to, and then click Transfer.
6. Click Start.

- Do not power off or disconnect the USB cable while updating.
- Close all other Brother applications.
5 Appendix

Maintenance

Before performing any maintenance, disconnect the USB cable and power off the label printer.

Clean the Label Printer Exterior

Wipe the label printer’s exterior with a soft, dry cloth to remove dirt or dust. If the label printer is heavily soiled, wipe it with a cloth dampened with some water.

Do not use solvents or agents such as benzene, paint thinner, or alcohol, which may damage the label printer’s surface.

Clean the Print Head

Streaks or poor-quality characters on printed labels generally indicate that the print head is dirty. You can use either the optional dedicated Head Cleaning Tape Cassette (TZe-CL4) or a cotton swab to gently wipe dirt from the Print Head.

Put the Head Cleaning Tape Cassette in the label printer, and press the Power Button twice quickly. Approximately 1 in. / 25 mm of tape feeds each cleaning cycle. If the problem is not solved after repeating this process three times, contact Brother customer service.

⚠️ CAUTION

Do not touch the Print Head. You may get burned.
Clean the Tape Cutter

Tape adhesive can build up on the cutter blade after repeated use, taking the edge off the blade which may result in the tape jamming in the cutter. Wipe the cutter blades using a cotton swab moistened with ethanol or isopropyl alcohol.

⚠️ CAUTION
Do not touch or insert your fingers into the cutter blade.
## Troubleshooting

### LED Indications

<table>
<thead>
<tr>
<th>Power LED</th>
<th>Lit/Flashing</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Lit</td>
<td>• Bluetooth connection established</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Feeding or cutting tape</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Printing</td>
</tr>
<tr>
<td></td>
<td>Flashing (0.5 second intervals)</td>
<td>• Receiving data from a mobile device or a computer</td>
</tr>
<tr>
<td></td>
<td>Lit for 3 seconds, then off for 1 second</td>
<td>• Transferring program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Standby</td>
</tr>
<tr>
<td>Orange</td>
<td>Lit</td>
<td>Initializing</td>
</tr>
<tr>
<td></td>
<td>Flashing (0.5 second intervals)</td>
<td>Cooling</td>
</tr>
</tbody>
</table>

### Battery LED

<table>
<thead>
<tr>
<th>Battery LED</th>
<th>Lit/Flashing</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orange</td>
<td>Not lit</td>
<td>Fully charged</td>
</tr>
<tr>
<td></td>
<td>Lit</td>
<td>Charging</td>
</tr>
<tr>
<td></td>
<td>Not lit for 3 seconds, then lit for 0.5 seconds</td>
<td>Only half the battery charge remains.</td>
</tr>
<tr>
<td></td>
<td>Not lit for 2 seconds, then flashing twice</td>
<td>The battery charge is low.</td>
</tr>
<tr>
<td></td>
<td>Flashing (0.5 second intervals)</td>
<td>Insufficient charge or battery failure.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Refer to the following table to solve the problem.</td>
</tr>
</tbody>
</table>
## LED Troubleshooting

<table>
<thead>
<tr>
<th>Power LED</th>
<th>Lit/Flashing</th>
<th>Condition</th>
<th>How to Clear an Error</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Red       | Flashing twice per second, then off for 1 second | • Insufficient charge  
• Battery failure | Lightly press the Power Button. | Charge the battery.  
If the problem is still not resolved, replace the battery. |
|           | Red         | • No Tape Cassette installed.  
• Incorrect Tape Cassette installed.  
• Incompatible Tape Cassette installed. | | Insert the correct Tape Cassette. |
|           | Red         | High temperature error | | Wait a short while, then try again after the Power LED changes to green. |
|           |             | Transmission error | Restart the label printer. | When using a mobile device:  
Establish a Bluetooth connection.  
When using a computer:  
• Reconnect the USB cable.  
• Change the USB port. |
|           | Lit         | Program transfer failure | Transfer the program again.  
If the problem is still not resolved, contact Brother customer service. | |
|           | Flashing (0.3 second intervals) | System error | Contact Brother customer service.  
(The flashing pattern may change if you touch the Power Button.) | |
If you need additional help, visit support.brother.com.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The label printer does not print.     | • Check that the Tape Cassette is inserted correctly.  
• If the Tape Cassette is empty, replace it.  
• Check that the Cassette Cover is securely closed.  
• Check that the charge is not low.  
• Check that the label printer is on.  
• Check that the mobile device is not in sleep mode.  
• Check that the mobile device’s Bluetooth setting is on.  
• Check that the label printer is connected to your mobile device via Bluetooth.  
• Check that the label printer is selected in the P-touch app.  
• Check that the label printer is not paired with another device.  
• Make sure the label printer and your mobile device are close enough to communicate.  
• Make sure no devices that emit radio waves (for example, a microwave oven) are located nearby.  
• Check that the correct printer driver is installed when printing from a computer.  
• Connect the label printer to your computer with the included USB cable when printing from a computer.  
• Check the label is not blank.                                                                 |
| • The tape does not feed correctly.   | • If the tape is bent, cut off the bent section.  
• If the tape is jammed, remove the tape cassette, pull out the jammed tape, and then cut it.  
• Check that the end of the tape out of the Tape Guide.  
• Confirm that the tape is pointed at the Tape Exit Slot.  
• Remove the tape cassette and insert it again.                                                                 |
| • The tape gets stuck inside the label printer. | A tape jam error cannot be cleared despite following the troubleshooting steps. Contact Brother customer service.                                                                                           |
| A horizontal gap runs through the middle of the printed label. | Streaks or poor quality printed labels generally indicate that the Print Head is dirty. See Maintenance: Clean the Print Head.                                                                                   |
| An error occurred when using a mobile app. | Go to your mobile app’s settings menu > Support page > FAQs & Troubleshooting                                                                                                                             |
| I want to cancel the current printing job. | Make sure that the label printer is on, and then lightly press the Power button.                                                                                                                       |
| The ink ribbon is separated from the ink roller. | If the ink ribbon is broken, replace the tape cassette. If not, leave the tape uncut and remove the tape cassette, then wind the loose ink ribbon back onto the spool.                                      |
## Appendix

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The label printer stops while printing a label.</td>
<td>Replace the tape cassette if striped tape is visible, as this indicates that you have reached the end of the tape.</td>
</tr>
<tr>
<td>While printing, striped tape appears.</td>
<td>The tape cassette is empty. Insert a new tape cassette.</td>
</tr>
<tr>
<td>The tape is not cut automatically.</td>
<td>Select <strong>Auto Cut</strong>. If using special tapes, cut the tape by hand.</td>
</tr>
</tbody>
</table>
| Printed barcodes or QR codes cannot be read. | • Try using another barcode scanner.  
• Try using another QR code reader application.  
• Change the tape.  
• Recommended: Black on white tape  
• Enlarge barcodes or QR codes using the application, if possible. |
| There is an approximately 1 in. / 25 mm of blank space at the leading edge of each printed label. | Most TZ labels have a clear laminate top layer. This durable laminate helps the label withstand abrasion, fading and wet conditions providing a crisp, readable image. The process of adding this laminate layer results in the leading edge of blank space. Adjusting the label’s margin or not cutting the last label may reduce the amount of blank space. |
| • I cannot turn on the label printer.  
• The label printer powers off when I try to print. | • The battery may be discharged. Charge it.  
• Make sure you have removed the protective sheet. See **Insert the Tape Cassette**. |
| It is not possible to charge the battery. | • Disconnect the USB cable and connect it again.  
• Make sure you have removed the protective sheet. See **Insert the Tape Cassette**. |
| Battery life is short, even when fully charged. | The battery may have reached the end of its life. Use a new battery. |
| I want to check I am using the latest version of the software. | Windows  
Use the P-touch Update Software to confirm if you have the latest version. See **Windows: Update Software**.  

Mac  
See [support.brother.com](http://support.brother.com). |
# Product Specifications

| **Dimensions** | Approximately 5 in. (W) x 2.6 in. (D) x 5 in. (H)  
Approximately 128 mm (W) x 67 mm (D) x 128 mm (H) |
| **Weight (with battery)** | Approximately 1.4 lb  
Approximately 640 g |
| **Operating temperature** | 50°F to 95°F  
10°C to 35°C |
| **Operating humidity** | 20% to 80% (without condensation) |
| **Interface** | Label printer side  
(for Windows/Mac)  
USB 2.0 Full Speed  
Bluetooth Version  
2.1 +EDR Class2 |
Appendix

**Trademarks**

Mac and Macintosh are trademarks of Apple Inc.
App Store is a service mark of Apple Inc.
Google Play is a trademark of Google LLC.
The Bluetooth® word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of such marks by Brother Industries, Ltd. is under license.
Wi-Fi is a registered trademark of Wi-Fi Alliance®.
Any trade names and product names of companies appearing on Brother products, related documents and any other materials are all trademarks or registered trademarks of those respective companies.